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Introduction
“Network FAX Ver. 4.4.x” is referred to as “Network FAX” in this manual.
Network FAX is a communications software package that integrates fax communication, document management and 
client management to increase the effi ciency of all your business communications.  

This software was developed to fi ll a need for effi cient and fl exible business communications. We hope our customers 
fi nd it useful. Please read this manual thoroughly to get the most out of Network FAX.

Important Notice

(1) This software is licensed, copyrighted, and owned by Comuse Co., Ltd. All rights are reserved and 
protected by Copyright Laws in the USA.

(2) Note that copying all or part of the content of this program or manual for any reason other than making 
a program backup without the permission of Comuse Co., Ltd. will breach the rules of copyright.

(3) Comuse Co., Ltd. may make changes to this manual or program content without notice in order to 
improve the quality of the product.

Copyright © 2003 by Comuse Co., Ltd. All rights reserved.

Microsoft Windows 98, Microsoft Windows 98SE, Microsoft Windows ME, Microsoft Windows NT, Microsoft Windows 
2000, Windows XP are registered trademarks of Microsoft Corporation, USA.
Other company and product names mentioned in this document are the trademarks and registered trademarks of their respec-
tive companies.
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Terminology Note
The term “network fax equipment” refers to devices such as copiers, facsimiles, printers and other machines that sup-
port network operation. In order to support the functions offered by Network FAX, network fax equipment must have 
RFC based Internet fax functionality. 
In this manual both Network FAX and Network FAX Communicator are referred to as “Network FAX” and the fax 
machine displayed on screen is referred to as a network fax equipment.

System requirements
Network FAX requires the following hardware and software to operate.

Component Requirements

PC main unit Machine specification requiring operation system

Hard disk space 50MB or more (A large amount of free space is recommended if
you choose to manage documents.)

Operation System Microsoft Windows 98 (including Second Edition)
Microsoft Windows Millennium Edition
Microsoft Windows NT (Server 4.0/Workstation 4.0)
Microsoft Windows 2000 (Server/Professional/Advanced Server)
Microsoft Windows XP (HOME Edition/Professional)
*Operation with Microsoft Windows 95 is not guaranteed.

Network Environmen Requires network environment that can support network fax
equipment or email server.

*1 If running Microsoft Windows XP, we recommend using Pentium 300MHz or higher.
*2 If running Microsoft Windows 2000, we recommend using 64MB or more and there is a maximum

memory limit of 4GB.
*2 If running Microsoft Windows XP, we recommend using 128MB or more.
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This section describes how to start and exit 
Network FAX.

Chapter 1 Overview of Network FAX

Chapter 2 Starting and Exiting
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faxl_01_01.indd 03.5.28, 3:52:24 PM9



faxl_01_01.indd 03.5.28, 3:52:24 PM10



Chapter

Overview of Network FAX

.... . . . . . . . . . . . . . . . . . . . . . .12Network FAX Flowchart

faxl_01_01.indd 03.5.28, 3:52:24 PM11



12

Network FAX Flowchart

System Flowchart

Windows Network FAX

CSV

Print

Fax Mailbox

Display
Print

Send

Network 
fax

equipment

Setup

Address 
Book

Cover page

Import entries for Address Book

Importing documents from other applications

Address bookCover page

Send Network fax equipmentApplication

Print command

faxl_01_01.indd 03.5.28, 3:52:25 PM12



O
verview

 of N
etw

ork FA
X

1

Network FAX Flowchart  13

Sending and receiving fl owchart

CSV

Application

Cover page Out Box Send

Display document 
Print document 
Print list

Undelivered 
Folder 

Sent folder

Trash folder

Shredder 

Address Book

Network 
fax 

equipment

faxl_01_01.indd 03.5.28, 3:52:25 PM13



faxl_01_01.indd 03.5.28, 3:52:25 PM14



Chapter

Starting and Exiting 
Network FAX

.... . . . . . . . . . . . . . . . . . . . . . . . . .16

.. . . . . . . . . . . . . . . . . . . . . . . . . . . . .16

.. . . . . . . . . . . . . . . . . . . . . . . . . .17

.. . . . . . . . . . . . . . . . . . . . . . . . . .17

.. . . . . . . . . . . . . . . . . . . . . . . . .18

.. . . . . . . . . . . . . . . . . . . . .19

Starting Network FAX

Exiting Network FAX

Starting Direct Fax 
Result Notices Setting

Exiting Direct Fax 
Result Notices Setting

Installing Network FAX

Uninstalling Network FAX

faxl_01_02.indd 03.5.28, 3:52:47 PM15



16

Starting Network FAX

Click Start  and then click Network FAX in the [Programs] menu.

Click Network FAX.

3 The application’s main window appears.

Exiting Network FAX

 From the main window of Network FAX, click [Exit] in the [Fax Mailbox] menu. Alternatively, click the  
button located on the top right corner of the window. 
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Starting Direct Fax Result Notices Setting

Click Start  and then click Network FAX in [Program (P)].

Click [Direct Fax Result Notices Setting] to display main window.

Exiting Direct Fax Result Notices Setting

From the main window of Direct Fax Result Notices Setting, click OK  or Cancel .

What is the Direct Fax Result Notices Setting?
This program is used to confi rm transmission result after giving a transmission instruction to the Internet fax from Network 
FAX. See page 28 “Setting up to Receive Direct Fax Result Notices” for details on how to set up.

Starting Network FAX / Exiting Network FAX / Starting Dirext Fax Result Notices Setting / Exiting Direct Fax Result Notices Setting
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Installing Network FAX
Follow these steps to install Network FAX.

Turn on the computer and start Windows.

Caution

• Close all other applications.

Note for users of NT/2000/XP:
• Before installing Network FAX on Windows NT, 

log on with administrator privileges.
• After installing Network FAX, login with the user 

name used during installation.

Install the CD-ROM.

3 To install this program, double click on the setup icon on the 
CD drive, and follow the Install shield Wizard instructions.

 Click Next  to start the installation process. 
Click Cancel  to cancel the installation pro-
cess.

 Select the folder where Network FAX will be 
installed. To use the default location, click 

Next .

3 In this example, the destination folder is set to 
“D:\Program Files\ComUse\skex”.

3 To change the destination folder, click Browse . 

 Select the program folder. To use the default 
program folder, click Next . 

3 The installation process begins.

 The fi nal wizard dialog box will appear to 
indicate that installation is complete. Click 

Finish . 
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Uninstalling Network FAX

Caution

• Before starting the uninstall process, exit all other appli-
cations.

Following these steps to uninstall Network FAX.

 Click Start , then point to [Settings] and click 
on [Control Panel].

 Double-click the [Add/Remove Programs] 
icon.

 Select Network FAX and click Add/Remove .

 

3 The InstallShield Wizard will start.

 When the message “Do you want to com-
pletely remove the selected application and 
all its components?” appears, click OK .

 If prompted with this message, “Save Net-
work FAX data?” click Yes .

 When the uninstall process is complete, click 
Finish .

Note

• If a message informs you that the uninstall process is 
complete but that some items could not be deleted, you 
can use the Windows Explorer or other method to go to 
the \ComUse\skex folder (or the folder specifi ed during 
installation) and delete any items. (To keep the Address 
Book or other data when installing a newer version of 
Network FAX, do not delete these fi les.)

 Restart Windows. 
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This section gives detailed instructions on using Network FAX. 
Chapter 1 explains how to configure Network FAX. Chapter 2 
guides you through the basic steps of sending a fax. Chapter 3 
and subsequent chapters provide advanced instructions and 
useful tips to help you get the most out of Network FAX.

Chapter 1 Configuring Network FAX

Chapter 2 Sending your first fax

Chapter 3 Sending a fax

Chapter 4 Using the Address Book

Chapter 5 Renaming and deleting 

documents

Chapter 6 Viewing Documents
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Before you start sending documents, user preferences and 
Network FAX must be configured to work with the current 
environment. 

Fax Setup

Document limits

Setting up to Receive 
Direct Fax Result Notices
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Fax Setup

 In the [Setup] menu click [Fax Setup].

3 The [Fax Setup] dialog box appears. 

 Enter the information and select any check boxes required.

Click OK  to confi rm your settings. 

3 Click Cancel  to discard any changes and close the dialog box.

A description of these options is included in the following pages.

Note

• With Windows NT, 2000 or XP, if you make a fax setup with administrator privileges and attempt to login with the user name and 
change the settings, the following dialog box is displayed.

 Click Yes  and the administrator’s setting display appears. 

 Click No  and the new [Fax Setup] dialog box is displayed.

• Settings not performed for ‘Network FAX’s email address (From)’, ‘Address book opened when send screen is displayed’, ‘Add 
message when destination is Email’, ‘Default cover page’, ‘Retries Times’ and ‘Retry Delay Minutes’.

 Set by each user.

Overview of Network FAX and the network fax equipment

Network FAX enables you to send data by e-mail or fax without switching applications. Network FAX differs from regular 
e-mail software in that both data sent by fax and data sent by e-mail is sent in TIFF format. Data sent by e-mail is sent as 
an attached TIFF fi le. The receiver of this TIFF fi le can view the contents by double-clicking the attachment. Imaging for 
Windows, an application that comes bundled with the Windows OS, can be used to view this fi le. 
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Network FAX and the network fax equipment fl owchart

This fi gure shows the Network FAX transmission process. The proper settings for Network FAX, the network fax equipment 
and the e-mail server are explained below. 

E-mail server E-mail

PC Network fax equipment Fax

B)

B)

C)
C)

A)

The Network FAX transmission process
A) Data is sent directly from the PC to the network fax equipment without going through an e-mail server.

• This method requires no e-mail server.
• With this method, messages cannot be sent as an e-mail.

B) Data is sent as an e-mail from the PC via the e-mail server.
C) Data is sent from the PC via the e-mail server to the network fax equipment. The network fax equipment then sends 

it to a remote fax machine in the same way a regular fax machine would.
D) Receiving Network FAX Process Results (Transmission Result Notices)

� Example:

AdohteM C&BsdohteM

sserddarevresPTMS — 1.001.861.291

s'rednes(sserddaliam-eXAFkrowteN
sserdda pj.oc.esumoc.op@troppus pj.oc.esumoc.op@troppus

niamodenihcamxaF — pj.oc.esumoc.xaF

sserddaPIenihcamxaF 002.001.861.291 —

revresPTMSssapyB detceleS detcelestoN

� SMTP server address
E-mail transmission requires an SMTP server (to send e-mail) and a POP3 server (to receive e-mail).

Enter the address of the SMTP server.

� Network FAX e-mail address (Sender’s e-mail address)
Normally the user e-mail address is entered here. This address is used to identify the sender of an e-mail. This address appears in the [From] 
fi eld in the message received. If an e-mail cannot be delivered, an failure notice is returned to this e-mail address.

When e-mail is rejected by the e-mail server, it is put in the Undelivered folder. 

Caution

• Be sure to enter a complete e-mail address (including 

he domain name, the part after the @ symbol. For example, the “mycompany.com” part of myName@mycompany.com) If the domain 
is omitted, some e-mail servers add a host name following the @, in which case the e-mail receiver may not know who to reply to. 
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� Fax domain
Set the domain of the network fax equipment when installing 
the network fax equipment itself. We recommend that you con-
sult your system administrator when performing this task. 

Reference

• To check the domain name of the network fax equipment, 
view [Local Device Domain Names] in the “Administra-
tor Maintenance Network Settings”.

Note

• Set the e-mail server DNS when installing the network 
fax equipment. We recommend that you consult your 
system administrator when performing this task.

Registering the domain name of the Internet fax 
machine with the DNS server
In order to send faxes directly, the network fax equip-
ment must be specifi ed as the e-mail server on the 
DNS server.
Example)
In this example, the e-mail domain name of the user’s 
department is “comuse.co.jp” and the IP address of 
the network fax equipment is “192.168.100.200”.
If the network fax is registered on the DNS 
server “comuse.co.jp” as fax.comuse.co.jp MX 
192.168.100.200, e-mail with the domain name 
“fax.comuse.co.jp” will be sent to the network fax 
equipment. 
In this case you would need to specify “fax.comuse.co.jp” 
as the network fax equipment’s “local device domain 
name”. 

� Fax IP address
Enter the IP address of the network fax equipment (this number 
is used to identify the target device). This setting is necessary 
when “Bypass SMTP server” is checked.

� Transmission Result Notices
This tells you whether or not the transmission from Network 

FAX to target fax machine has been successful.

� Do not use SMTP Server
Select this check box when you want data sent to a fax number 
by connecting directly to the network fax equipment.

� Show Address Book with Send Screen
This option determines whether or not to automatically open the 
Address Book when sending a message. Select this check box 
to open the Address Book automatically open.

� Insert message when address is e-mail
When sending to an e-mail address, the following message is 
added to the main text. “Image data (TIFF-F format) has been 
attached to the e-mail”. 

� Default cover page
This option determines the cover page to use when a send com-
mand is executed. Also, when re-sending from the undelivered 
folder or re-sending a document for which a Quick Send was 
performed, the cover page used by this document is used.

The other option(s) should be self-explanatory.

� Retry Feature
If the network fax equipment is unable to receive the docu-
ment from Network FAX, transmission jobs stay in the Outbox 
folder.
The retry feature then enables automatic re-transmit of those 
jobs.
This will enable Network FAX to retransmit the document until 
successful, or until the number of retries has been attempted.

� The number of retry 
Set the number of retries 0-9. When 0 is set, the retry will not be 
performed.

� The retry interval
Set the retry interval 1-9 minutes.
* Sending of the next document begins when retry for the wait-

ing document is complete.
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Document limits 
Document limits allow the user to limit the number of documents saved in each fax mailbox. When the document limit 
of the Trash folder is exceeded, the oldest document is automatically shredded. (See below for details on shredding.) 
This is true for other mailboxes as well.

To set the document limit

Click [Document Management] in the [Setup] menu. 

3 The Document Management dialog box appears.

Set the document limit for each item in the Document Management dialog box.

Fax Mailbox Document Limit Alarm Alarm Limit

Out Box 1-1500 (variable) Select or clear 1-1500

Undelivered folder 1-999 (variable) Select or clear 1-999

Sent folder 1-999 (variable) Select or clear 1-999

Trash folder 1-999 (variable) Select or clear 1-999

Set the alarms and alarm limits.
Select the check box to the left of the alarm.

3 An alarm will appear when the document limit is reached.

Saving sent documents
To save a sent document, select the [Save Sent Faxes] check box. 

Note

• The Difference between “delete” and “shred”

 When a document is deleted, it is placed in the Trash folder. When a document is shredded, it is permanently removed.

•  When sending using the broadcast function, we recommend that you do not select the [Save sent faxes] check box. If you decide to 
save documents, ensure that you have adequate hard disk space. 
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Setting up to Receive Direct Fax Result Notices
Once you set up to receive notices of direct fax results, results of transmission instructions from Network FAX to 
Internet fax device can be automatically or manually displayed.

Start the setting window for receiving notices of direct fax results.

Set each environment to be used in the PC IP Address (A) and Port No. (E) sections of the Communication 
dialog box.
* Here, if the [Automatic] setting is selected, the information of the machine that the software is installed on will be 

automatically inserted.

If “Window pop up notices (P)” is selected in the Notices dialog box, result notices will take the form of a 
pop up window.
Click on “Cleral all History (D)” to delete the log of received transmissions.

Click OK  to save settings. Click Cancel  to exit window without making settings.
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Quick Send
You can send a quick, one-page fax by writing a memo on the cover page. Only Letter size is available with Quick 
Send.

Writing the message

Click the Quick Send  button in the main 
window. 

3 The Quick Send dialog box appears. 

3 You can also display this dialog box by clicking [Quick 

Send] in the [Options] menu. 

Select a cover page sample in the [Cover 
Page] fi eld.

Enter the receiver fax number in the [Fax 
Number] fi eld.  

Note

• Click the [E-mail] in the [Address] button and enter an 
e-mail address in the text box to send the document as an 
e-mail attachment (TIFF fi le).

Enter the appropriate information in the [To] 
fi eld.

Enter the required information in the [From] 
fi eld. 

Note

• When the receiver and sender are registered in the Address 
Book, you can insert information by selecting the sender 
or receiver from the Address Book. For details, see “Fax 
sending methods”. The Address Book opens automati-
cally when [Show Address Book with Send Screen] is 
selected in the confi guration process. (See Chapter 1)
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Entering the fax message in the Memo 
input fi eld

To enter a quick message on the selected cover page, write 
a message in the Memo text box.

 Click the Memorandum  button in the Quick Send 
dialog box. 

3 The Memo dialog box appears.

Enter your message.

When fi nished, click OK . 

3 Different cover pages allow different message lengths. 
(The maximum message length is 700 characters.)

 Click the Cover Page Preview  button. 

3 The cover page layout appears on screen. 

3 You can adjust the document with the tool buttons 

provided.

When fi nished, click the  button. 
3 The Quick Send dialog box appears again.

 To send, click the Send  button.
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Overview of fax mailboxes and the fax sending utility
Fax mailboxes hold documents to be sent and serve as temporary holding places for documents. Each document folder 
serves a specifi c purpose and works with other folders. Click the respective fax mailbox (folder) button to view a list 
of the documents in a fax mailbox. There are four fax mailboxes and a shredder.

Fax mailboxes

1 Out Box
 Documents that have already been addressed are 

held in this folder until sent. A maximum of 1500 
documents can be kept in this folder. (This number 
can be changed. See “Document limits” in Chap-
ter 1).

2 Undelivered
 Documents that were not successfully sent are 

automatically kept here. A maximum of 999 doc-
uments can be kept in this folder. (This number 
can be changed. See “Document limits” in Chap-
ter 1). When the number of documents exceeds 
the limit, the oldest document is moved to the 
Trash folder.

3 Sent
 Sent documents are automatically kept here. A 

maximum of 999 documents can be kept in this 
folder. (This setting is performed using [Mailbox 
Management] located under [Setup].) When the 
number of documents exceeds the set limit, the 
document marked with the oldest date is either 
moved to the Trash folder or Shredder.

4 Trash
 Documents that have been deleted from other fax 

mailboxes or documents that have moved when 
document limits are exceeded are kept in the Trash 
folder. A maximum of 999 documents can be 
kept in this folder. (This number can be changed. 
See “Document limits” in Chapter 1). When the 
number of documents exceeds the limit, the oldest 
document is permanently removed.

5 Shredder
 The shredder permanently removes documents. 
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Document lists

The status of documents in the document list is indicated with the following fl ags.

• Flag legend
V : Document has been viewed.
P : Document has been printed.
T : Document was sent at a designated time.
E : Document was sent via “Quick Send.”
N : The [Do Not Save] option is selected. (See “Mailbox Management” in Chapter 1).
M : Document was sent as e-mail.

Fax mailbox operations

noitcnuF/redloF eltiT yalpsiD eteleD noitcnuF/redloF eltiT yalpsiD eteleD

xoBtuO oN oN seY derevilednU seY seY seY

"tnemucodevaS"tneS seY seY seY ]evaStoNoD[tneS oN oN seY

hsarT seY seY seY redderhS oN oN oN

faxl_02_02.indd 03.5.28, 3:53:57 PM33



faxl_02_02.indd 03.5.28, 3:53:57 PM34



Chapter

Sending a fax

... . . . . . . . . . . . . . . . . . . .36

.. . . . . . . . . . . . . . . . . . . . . . . . . . .37

.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38

.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .41

.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42

.. . . . . . . . . . . . . . .44

Flowchart of fax functions

Fax sending functions

Faxing methods

Confirming fax transmissions and 

re-sending

Broadcasting

Reserving a transmission time

faxl_02_03.indd 03.6.17, 3:12:16 PM35



36

Flowchart of fax functions

Click the [Quick Send] button.

Use an application to create a document 
and run the print command using the 
Network FAX printer driver.

Select a document from any fax mailbox 
and click the [Send] button.

Enter the appropriate 
information

Check that the document was 
sent successfully.

If the document was not sent 
successfully, re-send it.
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Fax sending functions

Click the Quick Send  button in the main window.

3 The Quick Send dialog box appears.

Caution

• If a document is not selected the Send  button is dimmed. The Send  button is used to send an existing document from the fax 
mailbox.

Button Description

E-mail Select to enter address manually.

Fax Number Select to enter the fax number manually. Click the buttons 0-9 or enter numbers from the keyboard.
Alternatively, select the receiver from the Address Book.

Address List View and edit an address list for broadcasting.

Title Insert a title up to 30 characters long.

Cover Page View a list of cover pages. Click the desired cover page to use it.

Address Book Display the Address Book of receivers and senders. Click the Address Book button in the [To] or
[From] fields.

Memorandum View the memo dialog box. Input a simple message (memo).

Cover Page Preview Display the cover page and the content of the document to be sent.

Send Send the document.

Cancel Cancel the current translation, and display the main window again.

Get Transmission Result
Notices Set up transmission result notices.
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Faxing methods
There are three methods for sending faxes: “Quick Send”, “Send from application” and “Send document from fax 
mailbox”.

Sending a one page fax (Quick Send)

You can insert a message in the memorandum of a cover 
page and send it is a simple one-page fax. “Quick Send” 

faxes can only be sent using Letter size. Click Quick Send  
in the main window. The Quick Send dialog box appears. 
Enter the required information (such as the receiver fax 

number) and click the Send  button to send the docu-
ment. (For more details on Quick Send see “Quick Send” 
in Chapter 2.)

Sending a document created in 
another application

Use this method to send a document created in another 
Windows application (such as Notepad or MS-Word). 

 Create the document in the other application. 

 Click [Print] in the application [File] menu.

3 The application Print dialog box appears. 

Caution

• If the application does not have a option for selecting 
the printer in the Print dialog box or if the print com-
mand causes the document to be printed directly, locate 
the dialog box where the printer is selected. The [Print 
Setup] or [Page Setup] commands in the [File] menu 
may contain this option. Select “Network FAX” as the 
printer and then print the document.

 Click “Network FAX” in the printer options sec-
tion in the Print dialog box.

Verify that the settings are complete and click 
OK .

3  “Network FAX” automatically starts and the Send Fax 
dialog box appears.

Enter the appropriate information into the [Fax 
number] fi eld, the [To] fi eld and the [From] 
fi eld. This information can be inserted from the 
Address Book as well. We suggest that often-
used information is saved in the Address Book 
to save time
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• Entering information in the Address Book
1 Click the Address Book  button in the [To] fi eld of 

the Quick Send Fax dialog box. The Address 
Book dialog box appears.

2 Click the New Record  button and enter the 
appropriate information in each fi eld.

3 Click OK . Then select the entry just made 
and click the [Designate] button. The Send Fax 
dialog box appears again.  

 The information is now entered in the Address 
Book and you have entered the necessary infor-
mation for the [To] fi eld of the Send Fax dialog 
box. 

4 Repeat steps 1-3 to enter and then insert the 
sender’s details.

Note

• To send the document by e-mail as an attachment (TIFF fi le) 
enter an e-mail address for the receiver.

To send a cover page with a document cre-
ated in another application, choose a cover 
page from the list in the [Cover Page] fi eld. To 
write a message on the cover page, click the  
Memorandum  button.

After entering the appropriate information, 
click the  Send  button. 

3 The fax sending process begins.

Note

• If the receiver and the sender are in the Address Book, 
their information can be inserted automatically into the 
related fi elds in the Quick Send dialog box directly from 
the Address Book. To have the Address Book open auto-
matically when sending, select the [Show Address Book 
with Send Screen] check box (See Chapter 1).

Sending a document from a fax mail-
box

Documents held in the Network FAX document folders 
(Sent folder, Undelivered folder, or Trash folder) can be 
sent directly from the folder. This is the easiest way to send 
a document.

From the main window, click the fax mailbox 
containing the document to send. 

3 A list of documents appears.

 Click the document to send. 

3 When clicked, the document is highlighted. 

Click the Send  button. 

3 The Send Fax dialog box appears.
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Note

• To have the Address Book open automatically when send-
ing, select the [Show Address Book with Send Screen] 
check box (See Chapter 1).

Click the Address Book  button in the [To] fi led 
of the Send Fax dialog box. (Alternately, this 
information can be entered manually.)

3 The Address Book recipient list appears.

 Click the receiver of this fax in the Address 
Book list. 

3 The receiver is highlighted.

 Click the Designate  button. 

3 The Send Fax dialog box appears with the [To] fi eld 
entry completed. 

Note :

• To send the document as an e-mail attachment (TIFF fi le), 
enter an e-mail address in the Address fi eld. 

Click the Address Book  button in the [From] 
fi eld to display the Address Book sender list. 
Repeat steps 5-6 to complete the [From] fi eld 
(Alternately, this information can be entered 
manually).  

3 To cancel the fax sending operation, click the Cancel  in 
the Send Fax dialog box.

 To send a document from a document folder 
with a cover page, select the cover page from 
the drop down list in the [Cover Page] fi eld.

 To write a brief memo on the cover page,  
click the Memorandum  button.

After completing all the necessary informa-
tion, click the  Preview  button and check that 
the information entered is correct. 

 Click the Send  button to send the fax.
To stop the fax from being sent, click the Send Abort  
button. 

Note

• If the [Save sent faxes] check box is not selected in the 
[Fax Mailbox] dialog box in the [Setup] menu, docu-
ments cannot be sent from the Sent folder and docu-
ments sent by Quick Send cannot be sent from the fax 
mailboxes.
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Confi rming fax transmissions and re-sending
A fax transmission may fail for a variety of reasons. To confi rm that the transmission was successful, do the follow-
ing. 

Confi rming fax transmissions

Click the Sent  button in the main window. 

3 The list of sent documents appears.

 If the document appears in the sent document 
list, then the document was sent without a 
problem. 

3 If the document is not in the Sent folder, then it was
not sent successfully. Documents are stored in the Unde-
livered folder when they fail. To view the list of unde-
livered documents, click the Undelivered  button. Follow 
the steps below to re-send undelivered documents.

3 Some documents in the Outbox folder could be waiting 
for the retry timer to elapse, and are still attempting 
transmission. If these fi les are subsequently sent to the 
MFP, they will then be put in the Sent Folder.

Re-sending undelivered documents

While automatic retry is available by setting from the Fax 
Setup screen,manual re-sending is also available from the 
Undelivered folder.

Click the Undelivered  button in the main 
window. 

3 A list of undelivered documents appears.

 Click the document you want to re-send and 
click the Send  button. 

3 The Send Fax dialog box appears. Make any necessary 
changes, such as the receiver address.

Click the Send  button. The document is re-
sent. 

3 When the transmission is complete, the document is 
moved to the Sent folder. 

3 To check that the document is now in the Sent folder, 
click the Sent  button.
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Broadcasting
Using the Broadcast function, a single fax message can be sent to multiple receivers automatically. 
When broadcasting, the name of the receiver is changed for each transmission, while the body of the message remains 
the same. 
The example below uses the Quick Send dialog box, but the steps are the same for broadcasting from an application 
or a mailbox. 

Click on the Quick Send button in the main 
window. 
Or select [Quick Send] from the [Option] menu. 

3 The Quick Send dialog box appears. 

Select a cover page from the Cover Page 
list. 

Click the Address Book button in the To area. 
Select the receivers to be included in the 
broadcast. 
To select all the receivers, click Select All in the 
Edit menu of the Address Book. 

To exclude a receiver that has been selected, click 
that recipient while holding down the [CTRL] 
key. Also, to select all the receivers, press [A] key 
while holding the [CTRL] key.

Note

• The destination data registered in the address book 
[Receiver [Receiver, MDB]] may be searched, and the 
fax message broadcast to the selected recipients.

• Refer to ‘Searching Address Book Records’ for details of 
searches.
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When the Designate button is clicked or 
[Designate(I)] is selected from the [Edit(E)] 
menu, a confi rmation message appears to 
confi rm which addresses to use, either e-mail 
or fax. 

When a selection is made, the Quick Send dialog 
box appears again and Broadcast is shown in 
either the E-mail fi eld or Fax fi eld, depending on 
which option was selected. 

E-mail

Fax

Enter the From data and a memo. 

Click the Cover Page Preview button to check the 
layout. 

Click the Send button in the Quick Send dialog 
box to begin broadcasting. 
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Reserving a transmission time

Using TimerSet function, a fax message can be sent at 
reserved time.

Click the [TimerSet(S)] check box in the Fax 
send screen. 
The TimerSet fi eld is displayed.

Enter the year, month, day, hour, and minute 
for the reservation in the relevant fi elds.

Enter information in the [Cover Page], [To], 
[From], and [Memo] fi elds, and verify the 
layout as required. 
Click Cancel  to cancel sending of the fax if nec-
essary.

Click Send . 
The entered document is placed in the send box, 
and is sent automatically at the reserved time.

Note

• [T] is added in the fl ag fi eld in the document list if a time 
is reserved.
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Address Book Outline
With the Address Book you can:

■ Record sender information (name, company, address, fax number, e-mail, etc)

■ Record recipient information (name, company, address, fax number, e-mail, etc)

■ Edit, delete, copy, and search through Address Book records

■ Create new Address Books and switch between them

■ Import and export Address Book data

■ Send documents from the Address Book

■ Store up to 1,000 records

Opening the Address Book

Click the Address Book  button in the [Network 
FAX] dialog box. 
Or select [Address Book] from the [Options] 
menu.

3 The [Address Book] dialog box appears.  

Closing the Address Book

Select [Exit] from the [Address Book] menu in 
the [Address Book] dialog box. 

3 The Address Book closes.

Opening and Closing the Address Book
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Address Book Elements
This section describes Address Book functions. 
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Create New Address Book Records
This section describes how to create new records in the Address Book.

Click the New Record  button in the [Address 
Book] dialog box. 
Or select [New Record] from the [Edit] menu. 

3 The [New Record] dialog box appears. 

Complete the desired fi elds in the [Name] tab. 

・Name: Enter the name. 
・Company: Enter the company name. 
・Department: Enter the department where the 

person works. 
・Position: Enter their job title or position. 

Click the [Address] tab and fi ll in each box.

・Address1: Enter an address. 
・Address2: Enter more address information. 
・Zip code: Enter the postal code. 
・Phone: Enter the phone number. 
・FAX: Enter the facsimile number. 
・E-mail: Enter the e-mail address. 

Click the [Other] tab and fi ll in each box. 

・Short Title: Enter a short, memorable title for 
the memo.

・Notes: Enter a note.

When fi nished, click the OK  button.
The OK  button can be clicked from any tab 
selection. 

The information just entered appears in the 
[Address Book] dialog box. 
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Editing, deleting, copying, and searching Address Book records

Editing Address Book Records

This section describes how to edit Address Book records.

In the [Address Book] dialog box list area, 
move the cursor to the address book record to 
be edited and click the Edit  button. 
Or select [Edit] from the [Edit] menu.

3 The [Edit] dialog box appears.

Make any desired changes, and when fi n-
ished with these steps, click the OK  button. 
The tab items are the same as the [New Record] 
dialog box. 

Make any desired changes.

Deleting Address Book Data 

This section describes how to delete Address Book 
records. 

In the [Address Book] dialog box list area, 
move the cursor to the address book record 
to be deleted. 

Click the Delete  button. 
Or select [Delete] from the [Edit] menu. 

A message appears to confi rm the selection. 
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Click the OK  button. 

3 The data is deleted.

Copying Address Book Records

This section describes how to copy an existing record and 
then save it after editing. 

In the [Address Book] dialog box list area, 
move the cursor to the address book record 
to be copied. 

Click the Copy  button. 
Or select [Copy] from the [Edit] menu. 

3 The [Copy] dialog box appears. 

Edit any of the tab items, then click the OK  
button. 

A copy is made and added to the list area. 

Searching Address Book Records

There are four types of searches possible. 

Search

This is the standard search function. 
The results can be sorted by selecting sort options 
at the bottom of the dialog box. 
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Search on Item

This option searches on any fi eld. 
The results can be sorted by selecting sort options 
at the bottom of the dialog box. 

Search on Group

Search a group. 

Jump to Search

This function allows searching on fi elds within 
the search results. 

Note

•  The search process works by comparing characters start-
ing with the fi rst character in each string.

 Example: A search string of CO will fi nd COMUSE but 
a search string of MU will not. 

Search

Enter a string to be searched in the Search String box in the 
Search dialog box, and then click the Search  button. 

3 All the records and fi elds are searched with the results 
for any matches shown in the main window. 

Example: Searching for the letter “T”
 Any records whose First Name or Last 

Name fi eld is T will be shown in the 
main window.

Search on Item

The search can be limited to specifi c fi elds. 
For example, a search could be done using both the First 
Name and the Company fi elds. 
The search is done on all the records in the Address Book. 
The search results are shown sorted by the First Name fi eld 
of the Name tab. 

Name tab
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Address tab

Others tab

Search on Group

This function shows all the records assigned to a particular 
group. 

Select the group name, and then click the Search  button to 
display all the members of that group. 

Jump to Search

This function allows searching on fi elds within the search 

results. 

To use the Jump to Search function, select the 
Jump to Search under Serch menu. 

After the Jump to Search dialog box appears, 
select a fi eld to search on from the Item list, and 
then enter the search string in the text box and 
click the Start  button. 

Example: Searching for “m” in the First Name fi eld. 

After clicking the start button, the cursor (right 
arrow) moves to the fi rst record in the list whose 
fi eld contains the search string. 

To select this address, click the Select  button. 

3 The selected record is highlighted. 
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Multiple Address Books
An unlimited number of Address Books can be created. 
Contact information can be categorized by creating a different Address Book for each group, such as work contacts and 
personal contacts.

Select [Switch Database] in the [Address 
Book] menu.

Click the Next Search  button to search for the next 
record whose fi eld contains the current search 
string. 

The cursor moves to the next record whose fi eld 
contains that search string. 

To select this record also, click the Select  button. 

The selected item is added to the list of selected 
items and is also highlighted. 

Repeat this procedure to select other records as 
well. 

Note

• The fi eld to search on may be changed any time during 
the search.

Displaying All Address Book Records

Select View All in the Edit menu to view all Address Book 
records. 
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Import and export Address Book data
This section describes how to import and export Address Books.

Import Address Books 

This section describes how to import Address Books in the 
following fi le formats. 
・CSV format
・Access format

Importing CSV formatted information. 

Select [Import] from the [Option] menu. 

3 The [Import] dialog box appears. 

Select the type of fi le to import and click the 
Next  button. 

(Select [CSV] this time.) 

3 The Open File dialog box appears.

Click the Browse  button and select the CSV fi le 
to import, then click Next  button. 

3 The fi eld selection dialog box appears. 

Select the fi elds to import and the import 
order and click the Next  button. 

3 The fi elds selected for import are displayed in the 
[Layout] section to make fi eld selection easier. 

Add  : Moves the selected item in the [Non-Import 
Item] to the [Import Item] list. 

 Select [(dummy)] for fi elds that do not contain 
data. 

 If [(dummy)] is not selected for fi elds that do 
not contain data, the fi eld names and values will 
not be properly aligned. 

Remove  : Removes a fi eld from the [Import Item] list. 
Up  : Moves the selected item higher in the list. 
Down  : Moves the selected item lower in the list. 

Delimiter: Determines the fi eld marker (either a comma or 
a tab) in the imported fi le. 
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Click the Import  button. 

3 The selected fi elds are imported from the selected fi le. 

Address Books Export (Export)

You can export address book data in CSV format or Win-
dows address book format.

Click [Export (E)] in the [Option (O)] menu to 
display the Export window.

Select either CSV or Windows address book 
as the export format.
Input the name of the fi le to be exported, and click 

OK  to export it to the folder that Network FAX 
is installed in.
Click Browse  to enable free selection of export 
target.

Note

• You can assign fi les you want to export by transferring 
them from [Export Items] to [Non-export Items]. Also 
you can return them back to [Export Items] from [Non-
export Items].

Items Exported between Network FAX Address book 
and Windows Address book

Network FAX Address book Windows Address book

1 Company Company

2 Department Department

3 Position Job Title

4 First Name First Name

5 Last Name Last Name

6 Address 1 Street Address

7 Address 2 City(, State)

8 Fax Fax

9 Phone Phone

10 E-Mail E-Mail Address

11 Short Title Display

12 Notes Notes
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Changing document names
Document names can be up to 30 characters long, and descriptive document names make it easier to identify the docu-
ment. Titles such as “New Product Information” or “Orders from East-West Trading” help identify the document to the 
receivers as well.

Open the fax mailbox that contains the desired 
document.  

3 A list of documents appears.

Click the desired document.  

3 The title section appears highlighted.

Click the [Rename] button in the main 
window. 

3 A blank title entry fi eld appears.

Enter a title. 

3 The title appears in the document.

Note

• When sending a document from an application, the fi le 
name is automatically used as the title.
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Deleting documents
To delete documents stored in the respective fax mailboxes, take the following steps. We recommend that you delete 
all documents no longer required.

Deleting a document

Deleted documents are moved to the Trash folder.

From the main window, click the fax mailbox 
where the desired document is located. 

3 A document list appears.

Click the desired document and drag it to the 
Trash folder. 

3 After the document is dragged to the Trash folder, the 
following message appears, “Are you sure that you want 
to move the selected item to the Trash Bin?”

Click OK . 

3 The document is now deleted.

Shredding documents

Shredding the document permanently deletes it. This is 
different from putting a document in the Trash folder.

From the main window, click the fax mailbox 
containing the desired document.  

3 A document list appears.

Click the document to shred and drag it to the 
shredder.

3 After the document is dragged to the Shredder, the 
following message appears. “Are you sure that you 
want to permanently shred the selected item?”

Click OK . 

3 The document is now shredded.

Note

• The difference between “delete” and “shred”
 When a document is placed in the Trash folder, it is said 

to be deleted, but it is still retrievable. When a document 
is shredded, it is permanently deleted.
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Batch Deletion of Documents (Sent 
and Undelivered)

Perform this operation to batch shred the documents in the 
Sent folder and Undelivered folder.

Click the document folder in the main window 
(Sent folder or Undelivered folder) holding the 
document batch to be deleted to display the 
documents in list form.

Right click inside the document folder to be 
batch deleted, and click [All Delete (C)] from 
the displayed menu.

3 The “All Documents deleted.” message will be dis-
played.

Click OK  to batch shred indicated document 
folder.

Note

• The difference between “delete” and “shred”

• When a document is placed in the Trash folder, it is said 
to be deleted, but is still retrievable. When a document is 
shredded, it is permanently deleted.

• Try not to keep broadcast transmissions. If broadcasts 
are to be saved, be sure that the hard disc has plenty of 
free space.
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Viewing Documents
Documents in the Undelivered, Sent and Trash folder can be viewed on screen.

Document Display button
Use the Document Display buttons to zoom in, zoom out and rotate documents on the screen.

1) Move to first page.
2) Move to previous page.
3) Move to next page.
4) Move to last page.
5) Move to specified page.
6) Show at actual size.
7) Show at 1/2 size.

8) Show at 1/3 size.
9) Show at 1/6 size (A4, Letter)

Show at 1/8 size (B4, A3.Legal.)
10) Rotate 90° counter-clockwise
11) Rotate 90° clockwise
12) Rotate 180°
13) Delete current page
14) Close document display

1) 2) 3) 4) 5) 6) 7) 8) 9) 10) 11) 12) 13) 14)
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Viewing a document

From the main window, click the fax mailbox 
containing the desired document.  

3 A document list appears.

Click the desired document. 

3  The document appears highlighted.

Click the View  button or double click the 
selected document. 

3 The document appears with the Document Display 
buttons at the top of the window.

Click the 1 : 1  button. 

3 The document is displayed at 100%.

3 Adjust the document display using the other tools.

Click the  button. 
3 The Specify Page dialog box appears. 

Click the button of the page to view.

3 The selected page appears.

Click the  button. 
3 The current document closes and the main window 

appears.
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Deleting a portion of a document

 Select the document to edit and click the 
View  button. 

3 The Document Display panel appears.

Click the Select Page  button. The Specify Page 
dialog box appears. 

Click the button of the page to delete.

3 The specifi ed page appears. 

Confi rm whether or not to delete this page 
and click Delete Page  button.

3 The following message appears. “Delete currently 
displayed page?” 

Click OK . 

3 The specifi ed page is deleted. 

3 Click Cancel  to abort the delete action.

Caution

• A page cannot be deleted on one-page documents. One-
page documents must be deleted from the main window 
by dragging them to the Trash folder or shredder.
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Transmission Result Notices and Indication Function 
With this function, you can check mark the check box for “Get Notices of Transmission Results” at the “Transmission Set-
ting” window to enable notifi cation (display) at Network FAX of the status of the network fax device where the data was 
sent.

Creation of Data for “Transmission Result Notices”

To display the transmission result notices, check mark the check box for [Get Notices of Transmission Results (S)] at the 
transmission window when sending a document.
Documents sent with this particular check mark will have their transmission results displayed at the window for notifying 
transmission results at the Network FAX side.
The check mark is set as a default setting.

Interval between Transmission Result Notices

The interval between notices (display) of transmission result notices to Network FAX is automatically set at time of software 
installation; therefore, setting is specifi cally not required. However, the setting can be manually confi rmed by clicking Trans-
mission result manual renewal (R)” or “Transmission result manual renewal” in the “Option (O)” menu of the main window. 
Also, any of the results can be altered, and data transfer and status alteration also can be performed.
- Transmission Waiting Document Folder -
(1) Transferred to Sent folder as “successful.”

(1) Transferred to Undelivered document folder as “failed.”

(1) Transferred to Undelivered document folder as “result not received.”

- Undelivered Mailbox -
(1) Transferred to Sent folder as “successful.”

(1) Transferred to Sent folder as “failed.”
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Flowchart of Transmission Result Notices

Fax machinePC Network FAX

(1) Sends fax data.
(2) If transmission process from Network FAX to fax machine is successful, data will be stored in Sent folder.
(3) If transmission process from Network FAX to fax machine fails, data will be stored in Undelivered folder.

Icons for Data Handled in Transmission Result Notices

Time indication transmission result notices - not received

Icon Requirements

Time indication for timeout wait for transmission result notices

Transmission result notices - waiting status

Transmission result notices - transmission failed

Time indication document transmission result notices - transmission failed

Transmission result notices - not received

Time indication for timeout transmission result notices status/Time 
indication for timeout transmission result notices

Transmission result notices status/Transmission result notices - transmission 
success

Time indication for timeout wait for transmission result notices - waiting 
status

*  When there is a mark on the bottom right of an icon, it shows that there is data for the transmission result notices.

 A list of all the icons is printed on the next page.
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The Types of Icons Displayed in Network FAX Document Folders

Transmission failed

Time indication for document transmission failure

Transmission result notices - transmission failed

Time indication document transmission result notices - transmission failed

Transmission result notices - not received

Time indication transmission result notices - not received

Icon Requirements

Time indication for document waiting for transmission timeout

Normal documents/Successfully sent documents

Transmission result notices - waiting status

Time indication for timeout wait for transmission result notices waiting status

Time indication for transmission timeout document/Time indication for 
transmission

Time indication for timeout transmission result notices status/Time 
indication for timeout transmission result notices

Transmission result notices status/Transmission result notices - transmission 
successful

Time indication for timeout wait for transmission result notices

1

2

3

4

5

6

7

8

9

10

11

12

13

14

* When there is a mark on the top left of an icon, it shows that data has been transmitted with a time indication.
When there is a mark on the bottom right of an icon, it shows that data is for the transmission result notices.
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Troubleshooting

Network FAX 
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Sharing an e-mail address with other e-mail software
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Caution

• File sizes are limited depending on the e-mail server. Thus, when fi le sizes greater than 500KB may be rejected. If this occurs, divide 
the data into multiple fi les consisting of fewer pages to reduce fi le size.
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Additional Information

Printer Driver

1.Network FAX will not correctly adopt paper settings (Page Setup dialog box etc.) in some applications, even when specifi ed. If this 
problem occurs, try the following.

 • First set Network FAX for Windows as the default printer and then create a new document. 

 • Select the paper size in the Properties dialog box for Network FAX for Windows.

2. If the application uses lightly shaded lines (fi ne dotted lines) this may not be printed correctly. When using dotted lines, specify 
heavy shading.

3. To print a document as an image fi le, select the appropriate option, such as [Print as Image], in the application and then print.

Use with Windows 2000

Always log on as administrator when fi rst running the software. Failure to do so will prevent normal start-up.

Use with Windows XP

1.Always log on as administrator when fi rst running the software. Failure to do so will prevent normal start-up.

2.This software does not support Windows XP user switching. To change the user, fi rst log off as the current user, log on again as a 
new user, and run the software.

Log on again 
as a new user. Run the software.
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Errors at Start-up with Windows 2000/XP Professional

This should be performed by Windows 2000 and Windows XP Professional users when Network FAX cannot be started or 
run with user privileges on an NTFS formatted operating system.
The operating system format is either NTFS or FAT. Please check as follows to determine which format is used by your 
machine. The above error does not occur with the FAT format.

Windows 2000

Open [My Computer] from [Start].

Right-click the desired operating system and 
click the [Properties] menu.

3 The FAT format is used if FAT is displayed, and the 
NTFS format if NTFS is displayed, to the right of [File 
system:] in the [Properties] screen.

Windows XP Professional

Open [My Computer] from [Start].

Right-click the desired operating system and 
click the [Properties] menu.

3 The NTFS format is used if NTFS is displayed, and the 
FAT format if FAT is displayed, to the right of [File 
system:] in the [Properties] screen.
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Error Handling

The following explains the procedure employed when an 
error occurs and Network FAX cannot be started or run.
The following settings apply to both Windows 2000 and 
Windows XP.
* Always log on again with administrator privileges 

before entering the following settings.

Click [Start], [Programs], [Accessories], and 
[Explorer].
In [Explorer], right-click the Network FAX instal-
lation folder (normally C:\Program Files\ComUse\
skw) to display the menu. Click [Properties] on 
this menu.

Windows XP Professional

Windows 2000

Click the [Security] tab in the [Properties] 
screen.
In the top window of the screen, select the user 
name for whom Network FAX is to be started (the 
selected user name is highlighted). After select-
ing the user name, place a check in [Allow] beside 
[Full Control] in the bottom window of the screen, 
and click OK .

Windows XP Professional

Windows 2000
Setup is now complete.
Log on with the user name selected in 2., and start 
and run Network FAX.
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Note

The [Security] tab in the [Properties] screen may not be dis-
played with some settings in Windows XP. In such cases, 
change the settings as follows.

1 Click [Folder Options] on the [Tools] menu in the [Explorer] 
screen. Click the [Display] tab in the [Folder Options] 
screen.

2 Place a check in [Use simple fi le sharing (Recommended)] 
under [Advanced Settings] and click OK .

This will display the [Security] tab in the [Properties] 

screen.
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Network FAX Specifi cations

Network FAX

Basic Functions
Receiver Fax, e-mail, I-fax

Send size A4, B4, A3, Letter, Legal

Resolution 200 x 200 dpi (fine), 400 x 400 (super fine)

Code format Fax: MH, e-mail/I-fax: TIFF

Data conversion Converts fax data to BMP and TIFF data

On-screen document display Zoom in/out 4 settings, Rotate ±90° , 180° , Select page, Delete page

Send Functions
Write message on cover page Maximum of 700 characters

Broadcasting Maximum of 1500 addresses

Document Preview Available

Address Book Functions
Number of Address Book entries Maximum of 1000 entries per Address Book. There is no limit on the number of Address

Books.

Data entry fields Company name (40), Department (40), Position (20)

First Name (20), Last Name (20), Zip code (10)

Address 1 (40), Address 2 (40), Fax number (40), Telephone number (40)

E-mail address (128), Short Title (20), Notes (80)

Copy function Entries may be copied and edited.

Search Functions
All items Example "Dallas" searches for all instances of the word "Dallas".

Search for each item Search by specifying a particular item.

Group Select the group name.

Mailbox Management Function
Number of documents stored in
document folders

Limits the number of documents stored in each folder and the number of alerts that are
issued.

Undelivered folder processing Undelivered documents are stored here.

Trash folder Documents are moved to the Trash folder from any document folder. Old documents
are automatically put in the Trash folder when the document limit is exceeded for that
folder. Documents are permanently deleted from the Trash folder when the document
limit is exceeded for that folder.

Title insertion A title up to 30 characters long can be inserted to each document.

Items created by Network FAX Documents, lists of documents in the Undelivered, Sent, and Trash folders.
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